## Table of Contents

**Setting Up Your Document** ........................................................................................................... 3  
  Title and acceptance pages ........................................................................................................... 3  
  Content order, fonts and spacing ................................................................................................... 3  
  Final Format ...................................................................................................................................... 3  

**Page Numbering** .......................................................................................................................... 4  
  Adding page numbers for thesis/dissertation format ...................................................................... 4  
  Continuous numbering across multiple documents ......................................................................... 6  

**Styles** ............................................................................................................................................. 7  
  The Style Gallery .............................................................................................................................. 7  
  Changing the appearance of a pre-set style ...................................................................................... 7  
  Do you need the chapter number and the title of the chapter on separate lines? ......................... 8  
  Working with “run-in” headings ....................................................................................................... 8  
  Chapter-based, numbered headings ................................................................................................. 8  
  Heading styles allow you to jump around within the document ..................................................... 9  

**Generating a Table of Contents** ....................................................................................................... 10  
  Create a table of contents from built-in heading styles .................................................................. 10  
  Modifying a table of contents .......................................................................................................... 10  
  Updating the table of contents ......................................................................................................... 11  

**Manual-entry table of contents (two options)** .................................................................................. 12  
  Installing dot leaders as a tab setting ............................................................................................... 12  
  Using Word’s manual-entry table of contents template .................................................................... 13  

**Working with Tables and Figures** .................................................................................................... 14  
  Resizing tables and images .............................................................................................................. 14  
    *To use screen capture in Mac* ..................................................................................................... 14  
    *Working with the image* ............................................................................................................. 15  
  Generating a list of figures, equations, tables or plates ..................................................................... 16  
    *Adding a caption to a figure, equation or table* ........................................................................ 16  
    *Using cross-referencing to link body text with caption updates* ............................................. 17  
    *Creating and updating a list of figures* ...................................................................................... 18  

**Finishing Up** .................................................................................................................................. 19  
  Embedding fonts ............................................................................................................................... 19  
  Making a PDF from your source file ................................................................................................. 19  

**Getting Additional Help** .................................................................................................................. 20  

**Appendix: Working with Run-In Sub-Headings** ............................................................................. 21  
  Working with “run-in” sub-headings on PC systems ....................................................................... 21  
  Working with “run-in” sub-headings on Mac systems ...................................................................... 21
Setting Up Your Document

Title and acceptance pages

Electronic templates for title and acceptance pages for theses and dissertations are available from http://guides.lib.ku.edu/etd/ETD_Title_Page. Once opened, you can copy and paste these templates, formatting and all, into your thesis or dissertation:

1. Click Command + A to select all.
2. Click Command + C to copy.
3. Now switch back over to your own document and place the cursor where you would like the title or acceptance page to appear.
4. To keep the original formatting, after you have pasted in the title or acceptance page, click the clipboard icon that will appear in your document (at the bottom of the pasted-in text) then choose Keep source formatting from the Paste Options box.

Content order, fonts and spacing

<table>
<thead>
<tr>
<th>Content Order</th>
<th>Fonts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Title Page</td>
<td>▪ Use 11- or 12-point standard typeface for main body text</td>
</tr>
<tr>
<td>2 Acceptance Page</td>
<td>▪ 10-point font is acceptable for tables, captions and footnotes</td>
</tr>
<tr>
<td>3 Abstract</td>
<td>▪ Chapter and section headings may be bold and no more than 2 points larger than text size</td>
</tr>
<tr>
<td>4 Acknowledgements</td>
<td></td>
</tr>
<tr>
<td>5 Table of Contents</td>
<td></td>
</tr>
<tr>
<td>6 Main Body Text</td>
<td></td>
</tr>
<tr>
<td>7 Bibliography*</td>
<td></td>
</tr>
<tr>
<td>8 Appendices</td>
<td></td>
</tr>
</tbody>
</table>

* Bibliographies may also be located at the end of each chapter

Spacing

- Normally theses and dissertations use double-spaced formatting
- Single-spacing is acceptable in table of contents, footnotes, end notes, charts, graphs, tables, block quotations, captions, glossary, appendices and bibliography.

Final Format

<table>
<thead>
<tr>
<th>Final Document Must Have</th>
<th>Final Document Must Not Have</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title and acceptance pages</td>
<td>Signatures of committee members</td>
</tr>
<tr>
<td>Date</td>
<td>Blank pages</td>
</tr>
<tr>
<td>Abstract</td>
<td>Landscape page orientations</td>
</tr>
<tr>
<td>Table of contents</td>
<td>Running headers or footers</td>
</tr>
<tr>
<td>One-inch margins (minimum)</td>
<td></td>
</tr>
<tr>
<td>Embedded Fonts</td>
<td></td>
</tr>
<tr>
<td>Lowercase Roman numerals on front-pages</td>
<td></td>
</tr>
<tr>
<td>Regular Arabic numerals in main body text</td>
<td></td>
</tr>
</tbody>
</table>
Page Numbering

Thesis and dissertation formatting requires different page numbering styles within the same document—for example, lower-case Roman numerals (i, ii, iii) for the front matter, and Arabic numerals (1, 2, 3) for the body of the document. To create the different page numbering styles as required, you will first set up the lowercase Roman numerals, then insert a section break, then set up the Arabic numerals.

Adding page numbers for thesis/dissertation format

1. Click on the Insert tab.
2. Click on Page Number and from the drop-down list, choose Page Number.
3. In the Page Numbers box, use the Position drop-down box to choose a vertical location for your page number.
4. Use the Alignment drop-down box to choose a horizontal location.
5. The box that reads, “Show number on first page” should be unchecked.
6. Click the Format... button.
7. In the Page Number Format box, select the lower-case Roman numerals from the Number format drop-down item and then click OK in both the Page Number Format and the Page Numbers boxes.

The lowercase Roman numerals are for the front pages only. To set up the Arabic numerals for the main body of the document, you will need to install a section break.

Installing the section break

8. Open the Show All Characters view from the Word Home tab.
9. Place the cursor above the page break mark on your Table of Contents page (or a blank page acting as a place holder for your future table of contents).
10. From the Layout tab, click on Breaks to open the drop-down menu and select Next Page.

In the Show All Characters view, the section break will appear as follows:

To delete a section break, place your cursor on the section break and backspace or delete.

Now that the section break has been installed, you can change the page numbers in either section. Notice how the pages are still consecutively numbered, though, for now.

To set up Arabic numerals in the second section

11. Double-click in the header area of Section 2 (or the footer area if your page number is at the bottom of the page) to open the Header and Footer Tools menu.

12. De-select Different First Page then click Page Number then Format Page Numbers.
13. In the Page numbering section, select the option **Start at**. Type a 1 in the box if it doesn’t fill in for you automatically.

14. When finished, click **OK**.

15. Use the gray X icon to **Close Header and Footer** and return to the main body text.

If you make a mistake while formatting page numbers, simply click the **Undo** button as many times as necessary to return your document to a clean state. Trying to undo the settings by changing them back often does not work well.

To delete page numbers, double-click in the header or footer area where the page numbers are located, highlight the page number and click **Delete**.

**Continuous numbering across multiple documents**

To create page numbers that run continuously across multiple files (i.e., the first file contains pages 1-25 of the document, the second pages 26-59, and so on):

1. Insert page numbers as you normally would in all documents, and finish writing the document.
2. In the file containing the first part of the document, scroll to the end and note the number of the last page.
3. In the **Insert** tab of the second document, click **Page Number** and choose **Format Page Numbers** (be sure the cursor is in the main body of the text and not in the front matter first).
4. Type the correct starting page number in the **Start at** box and click **OK**.

![Page Number Format](image)
Styles

When used systematically, styles can save you a lot of time by allowing you to set the formatting for a certain type of text (such as a regular body paragraph, a heading, or a caption) in one place, then apply that formatting to all similar types of text throughout the document. Even more important, if you decide later that you want to change the formatting of one type of text (for example, to make the font size 11 points instead of 10), all you need to do is modify that one style definition; all the text that has been tagged with that style will be automatically updated. Styles also enable the use of many other timesaving features in Word, such as automatically generated tables of contents, tables of figures, and the page navigation tool.

The Style Gallery

Located in the Home tab, the Style Gallery makes it easy to set consistent, one-click formatting for headings throughout your document. Use the arrow on the right of the Styles box to scroll through the many options.

Changing the appearance of a pre-set style

For academic document formatting, you may need to set up different heading styles.

1. Highlight the heading or text you wish to format and make the necessary changes from the Home tab as you normally would.

2. When finished, without clicking back in your document, right-click on the intended heading listing in the Style Gallery, then select Update to Match Selection.

3. To change the next text to the new style, simply highlight it and click its designated name in the Styles box.

4. This same approach can be used to apply edits to an existing style throughout a document by highlighting the pre-formatted text, right-clicking on the heading name in the Styles box and choosing Update to Match Selection.
Do you need the chapter number and the title of the chapter on separate lines?

APA protocol (among others) requires that the chapter title follows the chapter number on the following line. Word, however, likes to dedicate just one full line to a style and will list page numbers twice in the table of contents if you use the “Enter” key to apply a style across two lines. To bypass this, instead hold down the Shift button while pressing Enter where you want to break the lines. Use this same approach for placing table numbers and titles on separate lines as well (also required by APA).

Working with “run-in” headings

This is a run-in heading. A run-in heading is one that shares the same line with the text it introduces. Third- through sixth-level subheadings in APA style and fifth-level subheadings in Chicago and Turabian styles currently make use of run-in heading formats. Working with run-in headings in the Mac environment requires the use of field codes. If you have access to a PC machine and need to work with run-in headings, you may find it much easier to simply switch machines. The appendix of this how-to guide includes step-by instructions for working with run-in headings for both Mac and PC versions of Word.

Chapter-based, numbered headings

Chapter-based headings are dependent upon styles and headings. If you want to use chapter-based headings, plan to reserve Heading 1 for your chapter titles. (Heading 1 is the default to which Word will attach chapter heads so it will save you some hassle down the line if you set it aside for chapter headings from the beginning.) When you have set all your chapter headers with Heading 1 using styles (see below),

1. From the Home tab in the Paragraph section, click on the Multi-Level List button (Note its similarity to the Numbering button to its left. Be sure to get the right button.)
2. Under the List Library heading in the drop-down box, choose the box labeled Chapter 1.

Once you click the Chapter 1 box, you will notice that the changes are applied immediately to your document. Subsequent use of the Heading 1 style will also result in similar formatting numbered with the next chapter. Your table of contents will also reflect the chapter headings.
**Heading styles allow you to jump around within the document**

Once your heading styles are in place, you can use Word’s Navigation Pane to quickly access all parts of your document. This function creates a table of contents in your left-hand side-bar with click-able entries for jumping from place to place within your document very quickly.

To open the Navigation Pane, click **View** then check **Navigation Pane**.

![Navigation Pane](image)

*Here, the Navigation Pane is on the left. Each of the entries represents titles previously set using heading styles. Note also the arrows to the left of each Level 1 heading item. These can be used to customize your view by collapsing and expanding the areas as you choose.*
Generating a Table of Contents

Word can generate a table of contents automatically—but in order for this feature to work, you need to format the document headings using the styles described above.

Create a table of contents from built-in heading styles
1. If you haven’t already, assign heading styles to each of your headings (see previous section).
2. When all of your table of contents items have been assigned heading styles, place your cursor in the exact location where you’d like to insert the table of contents.
3. On the References tab, click Table of Contents, and then choose the Custom Table of Contents… from the lower section of options. This will open the Table of Contents box, which will allow you to adjust the format of your table.

Modifying a table of contents
1. In the Preview box (to the right of the Formats box), you are given a preview of how the Table of Contents will look as it is currently formatted.
2. In the Show levels drop-down menu, the default number of headings included here is 3. You may need to re-set this number to accommodate the number of headings you plan to include in your table of contents.
3. Clicking Modify will enable you to adjust the style characteristics of each of the different table of content levels using the Style menu.
4. In the Style box (not shown), choose the table of contents (TOC) level you wish to change and again click Modify.

5. This will bring up the Modify Style box. To evenly double-space your table of contents, you will need to set each level to double-space by clicking the double-space icon in the Modify Style box, selecting OK, then returning to the Style menu to select settings for the next TOC level.

6. When you have finished all the modifications, click OK to all the boxes to complete the table of contents.

Updating the table of contents
When you change your document in any way that affects the pagination, you will need to update the table of contents. To do this,

1. From the Table of Contents group of the References tab, select Update Table.

2. The Update Table of Contents dialog box will appear. Select Update entire table to ensure that all pagination changes are reflected, then click OK.

3. The table of contents will be rebuilt to reflect any changes or additions to your document.
Manual-entry table of contents (two options)

If you prefer to type your table of contents by hand (rather than using heading styles), you may run into some frustration in getting the dots to space evenly between the chapter name and the page number. To resolve this issue and produce your own table of contents, you can either install dot leaders as a tab setting or use Word’s manual-entry table of contents template. Both solutions are explained in detail below. Please note that these approaches will not enable the table of contents to update automatically, so be sure to check that the page numbers listed are correct before finalizing your document.

Installing dot leaders as a tab setting

1. If you haven’t already, begin by typing in all the chapter headings and subheadings for your table of contents. Don’t worry just yet about dot leaders or page numbers.
2. Set up all the indentions for subheadings according to your preference.
3. Highlight the entire table of contents in its current state.
4. Next, right-click (or Control+Click on some Macs) and select Paragraph from the pop-up menu.
5. In the Paragraph pop-up box, click Tabs in the lower left-hand corner (not shown here).
6. In the Tabs pop-up box, type 6" in the Tab stops: box, then click the plus sign icon to add the tab. Next, set the Leader radio button to ........ then click OK.
7. Now in your document place your cursor just after the first entry (Chapter 1, for example) and press the Tab key. This will move your cursor across the page and place the dot leaders for you.
8. Finally, type the page number then move your cursor to the end of the next line to set up the next page number.

Note: If you need to change the indentions on your table of contents, use the sliders on the Word ruler at the top of the page. You will not be able to change indentions using the Tab key. Click View and then Ruler if you don’t already see a ruler at the top of your document.

---

1 Instructions based on information from the Indiana University of Pennsylvania School of Graduate Studies and Research website: http://www.iup.edu/graduatestudies/resources-for-current-students/research/thesis-dissertation-information/writing-your-thesis-or-dissertation/dot-leader-instructions/
Using Word’s manual-entry table of contents template

1. Place your cursor where you would like the table of contents to appear.

2. Click on the References tab in Word, then click the Table of Contents drop-down at the far left of the ribbon.

3. From the Table of Contents drop-down, grab the scroll bar on the right and drag down to the section labeled Manual Table of Contents. From here, choose a template for your table of contents.

4. Word will place a starter table of contents into your document. Type your chapter titles in place of the dummy text and replace the page numbers with the correct numbers.

5. Copy and paste fields to create additional spaces for headings. (When copying, start from the right rather than from the left. When the text you want to copy is highlighted, click Command+C then Enter, then Command+V to paste the item.)
Working with Tables and Figures

Resizing tables and images
One of the easiest ways to work with images in your thesis or dissertation is to use screen capturing software to paste the image in as a clip, rather than inserting the image file. Images pasted in tend to be easy to resize, caption and move about the page. This approach will also work well for tables created in landscape-oriented layout format. (Remember that all pages of your thesis or dissertation must be portrait-oriented.) Landscape-oriented tables can be screen captured and re-pasted onto a clean, portrait-oriented page, then turned horizontally on the page as follows:

To use screen capture in Mac
1. Open the image you plan to use, or place it on your desktop. You may need to clear the space around it so that you can get a clean screenshot.
3. Position the cursor in the upper corner of the image you wish to capture, then hold the left mouse button and drag across the image.
4. A thumbnail of the image will appear among your desktop icons. Double-click on this thumbnail to open the image.
5. In the Preview application, click Edit then Select All to select the image.
6. Press Command + C to copy the image.
7. Place your cursor within the document where you would like the image to land, then click Command + V to paste the image to the page.
**Working with the image**

Once the image is pasted down, click once to select it, then right-click to open the menu options for the image. These include Insert Caption, Arrange, Grouping, Wrap Text and Format Picture, among others.

- **Wrap Text → Through:** This option will allow you to move the image freely around the page and will wrap the text accordingly. This can get tricky if you are using several images as the images tend to move when new ones are added. (Be sure to save often so you can return to earlier settings, if you wish.) You can also leave it set to “In Line with Text” to place one image in a horizontal space by itself.

- **Insert Caption:** Choose this option to add a caption to the image.

- **Format Picture → Line / Line Color / Line Style:** these options will create a border around the image. You can choose the color and thickness.

- **Arrange / Bring to front:** Use these option to layer images.

To rotate the picture, click it once to select then click the **Rotate** icon from the **Picture Format** menu at the top of your screen.

*Note that the Picture Format ribbon only appears when an image is selected!*
Generating a list of figures, equations, tables or plates

A table of figures lists all of the graphics, equations, tables, plates or figures in a document. Generating a table of figures is a two-step process. For a figure to be recognized it must have a caption so you will begin by labeling all your figures with captions. Then you can create the list of figures from those captions.

Adding a caption to a figure, equation or table

1. Click on the image you want to select then right-click and choose Insert Caption from the pop-up menu.
2. Next, fill out the dialog box including the Label and Position drop-down boxes.
3. Type a name for the figure (or table or plate, etc.).
4. If you need a label other than Figure, Table or Equation, as offered by Word, you can click on New Label to create your own. Your new label will be added to the list in the Labels drop-down box.
5. You may want to add a colon (:) or a period (.) after the figure number.
6. Click OK.
7. Once the label is in place, you can edit it by simply clicking on it and making whatever changes you like. The Caption box will not re-open for editing.

The figure numbers will automatically update for you as you go, but if you need to manually refresh the numbering, click Command+A to select all then right-click (or Control+click) and choose Update Field. The Update Table of Contents box will open and here, select Update Entire Table and click OK.

Note: To change your caption from blue to black, highlight the caption and adjust the settings as you normally would using the Font tools then, in the styles gallery, locate and hover over the style named Caption, then right-click and select Update to Match Selection. (If you can’t see the Caption style in the Styles Gallery, open the Styles Pane (it looks like this: ♦) then in the List drop-down, click All Styles.)
Using cross-referencing to link body text with caption updates
Once the caption is in place, you can link it to the body text as you choose. So for example, if you wanted to write, “Results in Trial 1 were varied and unpredictable, see Figure 1,” you could link this text to its associated figure. Here’s how:

1. Place the cursor where you would like the cross-referenced name of the figure to appear.
2. From Word’s References tab, click Cross-Reference.

3. In the Cross-Reference pop-up dialog:
   1. Use the Reference Type drop-down arrow to scroll down to the reference type of your choice.
   2. From the Insert reference to: drop-down arrow, choose how much information you would like to include in the text reference.
   3. Select the caption reference to link.
   4. When finished, click Insert. You may be able to see the cross-reference added to your document. If the Cross-reference dialog box does not close automatically, click the red X to close it. Do not click “Insert” a second time as this will add a second link to your document.

To update figures and cross-references individually, right-click on the cross-linked text and select Update Field from the pop-up menu or, for the entire document, use Command+A to select all before right-clicking.

Note: Cross-references may appear in italicized font. To change the font, see this guide by Word MVP Suzanne S. Barnhill:
http://wordfaqs.mvps.org/formatcrossreferences.htm
Creating and updating a list of figures

Once you have placed at least one caption, you can insert the list of figures.

1. First place the cursor where you want the table to go. Hint: You may want to turn on the “Show all characters” icon from the Home ribbon to ensure that you remain above the section break.

2. Next, click Insert Table of Figures from the References ribbon.

3. You will then see the Table of Figures dialog box. From the Caption label menu, choose the category for your table.

4. Like the Table of Contents dialog box, here you can also customize how your table will look or change the font or spacing of the table by clicking Modify and then Modify again to open the Modify Style box.

5. When you are finished making adjustments, click OK in all boxes to insert the table.

To update the table to reflect changes to your document, click on it once, then click Update Table from the References ribbon.

To update the figure numbers on the captions themselves (for instance, you removed Figure 3 and need to update the caption of Figure 4 to reflect the change), click Command+A to select all then right click and select Update Field.
Finishing Up

Embedding fonts
When submitting your thesis or dissertation online to ProQuest you will need to embed your fonts and convert your document to a PDF. Embedding your fonts allows others who may not have the same set of fonts on their system to still view your document as you intend it to be viewed.

A nice feature of Word 2016 for Mac is that fonts are automatically embedded for you. If you would like to double-check your PDF file to ensure that fonts are embedded:

1. Open the PDF in Adobe Reader. (You may need to right-click on the file name in your documents folder then hover over Open with... and choose Adobe Acrobat.)
2. Click File and then Properties.
3. Click on the Fonts tab. All embedded fonts will be listed here.

Instructions for embedding fonts are available at:
http://guides.lib.ku.edu/c.php?g=95218&p=617881

Making a PDF from your source file

1. From the top menu bar, click on the File tab and then choose Save as.
2. From the Save as type drop-down menu, choose PDF, then click OK to save. Choose the name and location for your PDF file, and provide any of the other additional information as well, then click Save.

If your computer does not have an option to save a document as a PDF file, you can download a free PDF converter from CutePDF at http://www.cutepdf.com/Products/CutePDF/writer.asp.

There are online utilities which will also convert a file to PDF for you, however, these do sacrifice the security of your document, as it has to be uploaded to a distant server for the conversion.

Further, Adobe Acrobat contains tools that allow you to modify PDF files (adding bookmarks, hyperlinks, and other elements), create a single PDF from multiple source files, and add interactive form fields (Pro version only). You must use Acrobat to use these advanced features. If your version of Word does not offer PDF creation or for more advanced PDF functions, many KU computer labs and libraries have Adobe Pro installed.
Getting Additional Help

http://guides.lib.ku.edu/etd
The KU Libraries LibGuide on Electronic Thesis and Dissertation contains how-to guides as well as links to additional resources. Here you can find pre-made templates for KU theses and dissertations in APA, MLA and Chicago style, how-to guides for other versions of Word, links to more information about final steps in the thesis and dissertation process and help guides on specific topics such as managing and formatting footnotes, working with equations, and applying running heads.

The Graduate School’s online Electronic Thesis and Dissertations Page contains additional information including topics such as working with digital images, copyrights, embargos, binding and electronic submission of your completed document.

http://www.copyright.ku.edu
Information about copyright services provided by the KU Libraries’ Shulenburger Office of Scholarly Communication & Copyright including general information about copyrights in the U.S., copyrights and scholarly publications, including theses and dissertations, Fair Use and scholarly work, and a Copyright Decision Tree – a tool developed at KU to help users decide whether they are using copyrighted materials in compliance with U.S. Copyright law and/or fair use.

www.infotraining.ku.edu
For free in-person training workshops including Electronic Thesis and Dissertation Formatting for Word or EndNote and Cite While You Write.

General information about KU computer labs:
http://technology.ku.edu/computer-labs
785/864-8080

The IT Virtual Service Desk also provides consulting and Q&A help in a variety of ways:
question@ku.edu
www.ku.edu/~helpdesk
785/864-0200

http://www.cutepdf.com/Products/CutePDF(writer.asp
If your computer does not have an option to save a document as a PDF file, you can download a free PDF converter from CutePDF. There are online utilities which will also convert a file to PDF for you, however, these do sacrifice the security of your document, as it has to be uploaded to a distant server for the conversion.
Appendix: Working with Run-In Sub-Headings

**Working with “run-in” sub-headings on PC systems**

If you have many headings that will require run-in sub-headings it may be quickest to switch to a PC computer (in the Watson library, for example) and follow the steps below. If a PC is unavailable, instructions for setting up run-in headings on a Mac are also included below.

**To apply run-in sub-heading styles, use the Style Separator:**
1. Type the text for the sub-header.
2. Hold down **Control+Alt+Enter** to insert a style separator.
3. Apply the desired heading style to the run-in sub-header text.
4. Place the cursor to the right of the style separator and continue typing normally. The style separator icons will not print in your finished document.

**If you need to use a style separator with text that is already in place:**
1. Place the cursor at the end of the text where you would like to apply the style.
2. Hold down **Control+Alt+Enter** to insert a style separator.
3. Highlight the text that is to form the heading and apply the desired heading style from the style gallery.
4. When finished, place the cursor again to the right of the style separator and continue typing as normal.

**Working with “run-in” sub-headings on Mac systems**

**IMPORTANT NOTE:** If you are using EndNote in Word, wait to do this kind of special formatting until after you have converted your EndNote-enabled document to plaintext (using the Convert to Plaintext command). This command will strip field codes from your document, and will thereby undo all your efforts here. Save this step until last. (Bulleted lists may also be “stripped” by EndNote).

In the document shown to the right, heading styles were utilized for heading levels 1 and 2, but field codes must be used for the run-in heading at level 3. **Instructions are in the purple boxes.**
3. In the Field box, click Index and Tables, from the Categories box, then TC from the Field names box.

4. Next, use Command+V to insert your copied text (as above) in the Field codes box.

5. Add quotes around the text.

6. Now, in the lower left-hand corner, click Options.

7. In the Switches box, select \l (backslash L) and click Add to Field.

8. When it appears in the Field codes box below, manually add your heading level (3 in this case) then press OK.
9. Click OK in both boxes.

Your document will not show the change unless you click the **Show All Characters** button.

---

**To insert the table of contents:**

1. Place the cursor in the location where you would like the table of contents to begin.

2. From the top menu, click **Insert**, then **Index and Tables**. The box illustrated here will open.

3. Click **Table of Contents** along the top menu bar.

4. In the **Show levels** box, set the number of table of contents levels you will use (in this case, 3).

5. Next, click **Options...**
6. In the Table of Contents Options, enable the Table entry fields box and click OK.

7. Click OK again in the Index and Tables box.

To update the table of contents, click once on the table of contents, then click Document Elements then Update.

In the Update Table of Contents box, select Update entire table and click OK.